
Cette session vise à soutenir une planification efficace et une estimation des ressources nécessaires à la mise 
en œuvre des interventions préventives de lutte contre le paludisme, en intégrant des outils et techniques 
modernes pour la géo-digitalisation : imagerie satellite, données SIG et analyses, afin de renforcer les efforts 
de prévention du paludisme.

Simex : Utilisation des outils géospatiaux 
pour la numérisation des campagnes

Réunion annuelle 
2025 des partenaires de l’Alliance pour la prévention du paludisme et 

réunion sur la numérisation des campagnes



Session 1 (30 minutes) :
Micro-planification et géo-digitalisation : 
Expériences des pays

Partage d’expériences nationales sur la mise en œuvre de stratégies de micro-
planification et de géo-digitalisation.
Facilitateur : OMS GISC

PreventionSession 2 (1 heure 45 minutes) :

Données et analyses pratiques pour la 
prévention du paludisme

Démonstration pratique de l'utilisation de l'imagerie satellite, des empreintes bâties, 
des données de population et de l'analyse de l'accessibilité pour la numérisation des 
structures de santé et la délimitation des zones de couverture.
Facilitateur : GISC + Participants

Session 3 (30 minutes) :
Exercice d’estimation des ressources

Exercice collaboratif axé sur l'estimation des ressources nécessaires pour des 
interventions efficaces de prévention du paludisme.
Facilitateur : GISC + Participants

Session 4 (15 minutes) :
Discussion et séance de questions-réponses

Forum ouvert pour discuter des programmes de lutte contre le paludisme, y compris 
des interventions préventives telles que la distribution de moustiquaires imprégnées 
et les campagnes de vaccination, ainsi que des défis et des attentes liés à la micro 
planification géo-digitalisée.
Facilitateur : Participants

Agenda



Microplanification et géo-digitalisation : Expériences 
des pays

The Alliance for Malaria Prevention Annual Partners Meeting and Campaign Digitalization Meeting
Mövenpick Hotels & Residence
Nairobi, Kenya from 7 - 11 April 2025



• Soutenir les données 
géospatiales et l’analyse.

• Augmenter l’utilisation 
efficace des SIG par les 
États membres et les 
partenaires.

• Promouvoir une 
communauté de pratique 
SIG à travers des formations 
et une expertise technique.

WHO GIS Centre for Health Établi en mai 2022

Contact: gissupport@who.int

mailto:gissupport@who.int


Catchment 
areas

Satellite 
imagery

Travel 
time

Spatial 
population

Health 
facilities

1. Cartographie des structures de santé et des 
sites de séances de vaccination.

2. Délimitation des zones de couverture et 
création de cartes de base.

3. Estimation de la population cible et distribution 
spatiale (y compris l’estimation à petite 
échelle)

4. Analyse de l'accessibilité géographique et 
optimisation des services

5. Cartographie thématique
Suivi sur le terrain et suivi des programmes

Applications des données géospatiales et de la technologie 
pour les micro plans



Création de cartes de base pour les microplans –
Atelier de cartographie participative

4 5Carte de base
Collecter et préparer la carte 
de base en utilisant des 
informations satellitaires et 
contextuelles

Portée et 
planification
Définir l’étendue de la 
zone et le type de 
campagne

Atelier
Organiser un atelier avec les 
superviseurs de terrain pour 
identifier leurs zones existantes

Validation sur le 
terrain
Validation sur le terrain des limites 
du microplan numérisé pour un 
contrôle de qualité

Intégration
Utiliser les microplans numérisés 
pour la planification opérationnelle, 
le suivi post-campagne et l’allocation 
des ressource

1 2 3

s



Création de carte de microplan

Les micros plans numériques sont créés à 
travers une série de formations et d'ateliers 
participatifs. Les composants clés 
comprennent :

• Cartographie des structures de santé et 
des sites de séances de vaccination

• Cartographie de la délimitation des 
zones de couverture et création de 
cartes de base

• Tableaux de bord en ligne créés pour 
toutes les zones de santé

• Collecte et regroupement des 
données spatiales et tabulaires 
supplémentaires nécessaires pour les 
microplans (par exemple, stockage et 
fournitures)



Les estimations de population à haute résolution provenant de sources secondaires aident à améliorer les 
estimations de la population cible des microplans. En utilisant l'analyse spatiale et l'estimation à petite 
échelle, les sources de données nationales officielles (par exemple, recensement, enquêtes, CRVS) 
peuvent être triangulées et améliorées/projetées pour l'année en cours et les objectifs.
Les données SIG utilisées pour améliorer les estimations de population peuvent inclure :

Amélioration des estimations de 
la population cible à l’aide des 
données géospatiales

Modelled estimates:
(Worldpop, GRID3, Facebook, etc)

Estimation à petite échelle : analyse 
géostatistique pour combler les lacunes 
des enquêtes nationales

Estimation à petite échelle : analyse géostatistique pour combler 
les lacunes dans les enquêtes nationales





Principaux avantages de la géo-digitalisation

Efficacité améliorée : La micro-planification SIG optimise 
l’allocation des ressources, la logistique des campagnes et le 
rapport qualité-prix.
Couverture améliorée : Les données quasi en temps réel, grâce 
à la capture des zones de couverture des structures de santé 
(sous-blocs), garantissent que tous les foyers sont ciblés, 
réduisant les opportunités manquées pour atteindre toutes les 
populations.

Suivi renforcé : Les tableaux de bord géo-digitalisés permettent 
aux dirigeants et aux décideurs de suivre les progrès en temps 
réel et d’obtenir des estimations de la couverture vaccinale.
Renforcement des capacités et transfert de connaissances 
durables : Les ateliers avec des spécialistes SIG sur site 
renforcent les capacités et assurent la durabilité à long terme et 
l’institutionnalisation.



GIS Microplanning Handbook and E-Learning Course

Planned translation in French
Geo-enabled Microplanning Handbook (link here)

https://drive.google.com/file/d/1ZEUaN5qtQyYmWwqSPJDUL4LaFl76p1Yr/view?usp=drive_link


Gestion de campagne unique (OCM)
Une approche intégrée pour la géo-digitalisation des programmes de vaccination

L'approche OCM dote les programmes de santé d'un flux de travail flexible et personnalisé pour planifier, 
exécuter et évaluer les campagnes avec précision, tout en étant intégrée aux systèmes de santé nationaux 
existants et à l'infrastructure.

Pre-campaign

• Les couches de données 
géospatiales 
fondamentales sur les 
estimations de 
population, les limites de 
santé et l'accessibilité 
peuvent être intégrées à 
tout outil de gestion et de 
suivi des campagnes.

•Développer des 
microplans numériques 
liés à la chaîne 
d'approvisionnement et 
au stockage.

•Créer, modifier, mettre à 
jour et imprimer des 
microplans.

•Renforcement des 
capacités et soutien SIG.

Intra-campaign

•Suivre et surveiller la 
mise en œuvre et les 
progrès du microplan via 
des tableaux de bord.

•Possibilité de mettre à 
jour les ensembles de 
données en temps réel 
via des applications de 
bureau et mobiles.

•Renforcement des 
capacités et soutien SIG.

Post-campaign

•Réaliser une analyse 
post-campagne de la 
couverture et de la 
population atteinte, 
comparaison avant et 
après la campagne.

Visualisation, accès 
modifiable et 
maintenance de toutes 
les bases de données 
pour tous les acteurs 
concernés (gestionnaires 
de données nationaux et 
infranationaux).

•Renforcement des 
capacités et soutien SIG.



Scaling up Geo-enabled Microplanning (2024-25)

2 Districts, 5M pop, 
3 months, 150K $

27 Districts, 72M pop, 
15 months, 1.7M $

77 Districts, 30M pop, 
(5yr plan), 7 dist. ( 

Y1, 200K $)
3 regions – 1M pop Province-East, South 

& Kandahar, 1M pop 2 Provinces, 1M pop 

Bangladesh Nepal Sudan Afghanistan Burundi

GMP is being scaled nationally 
in Bangladesh for the first 

time, proving its feasibility and 
effectiveness.

Bangladesh Country Office's 
work influenced Nepal’s 

strategy

A successful pilot tested 
cost-effective methods.

Nigeria

10 LGA – pilot and 
scale up

Proof of 
Concept

National 
Scaleup

National 
Rollout

Early stages of 
discussion 

Polio 
support

Bednet distribution Polio 
support

Early discussions with 
Sudan CO on implementing 
in Red Sea, Kassala, and 

Atbara

With D2D restrictions, 
focus on mapping health 
facilities, temp sites, and 

population modeling.

Supported Malaria bednet 
distribution with satellite 

imagery and pilot 
workshops

Initial talks with RO & CO 
on a full digital 

microplanning package

Components of 
Digital 

Microplan

The COVAX investments enabled the development of the Geo-
Enabled Microplanning (GMP) Handbook, setting a global standard 
and facilitating scale-up. Additionally, discussions are ongoing with 
Cameroon, Chad, Niger, CAR, and Somalia for implementation. Handboo

k



Bangladesh : Lacunes identifiées dans la microplanification conventionnelle

· Moins de couverture de la vaccination active
et pratique de suivi de la logistique.

• Erreurs dans la distribution des sites de séance, 
sélection des zones mal desservies, ce qui 
entraîne une mauvaise planification.

• Absence de planificateur de séance numérique 
en temps réel pour le suivi et la supervision.

• Difficulté à identifier les zones difficiles d’accès 
et à haut risque.

• Informations répétitives dans le microplan 
("copier-coller" : préparé sans aucune 
modification).



Cartes – Résultat de l'atelier



Site de 
vaccination  

ajouté dans la 
vaccination 

urbaine

2024 2023



Centre de 
réhabilitation et le 
nouveau site de 
peuplement des 
personnes sans 

abri de cette union 
dans une autre 

union (en raison de 
l'érosion fluviale)



Session pratique sur les données et l'analyse pour la 
prévention du paludisme :

The Alliance for Malaria Prevention Annual Partners Meeting
Mövenpick Hotels & Residence
Nairobi, Kenya from 7 - 11 April 2025

Former des groupes
-Au moins 1 ordinateur portable par groupe
-Collecter des cartes satellites
-Un problème sera donné, 1 ou 2 groupes seront 
invités à présenter



Burundi – Suivi du changement dans l'incidence du paludisme –
2016 et 2022

Malaria Atlas Project | Data

https://data.malariaatlas.org/maps?layers=Malaria:202406_Global_Pf_Parasite_Rate


Training on use of geospatial tools for microplanning of ITN distribution 
campaign
Digitalization of health facility catchment area and distribution points 

Objectif principal
L'objectif principal est de fournir une brève introduction au processus de 
délimitation des zones de couverture sur une carte papier et de les 
numériser à l'aide du logiciel QGIS, dans le cadre de la micro planification 
numérique pour la distribution des kits de prévention du paludisme.
Objectifs specifiques:
❑ Présenter brièvement le processus en cinq étapes de la 

microplanification
• Exercice interactif pour délimiter les zones de couverture respectives
• Explorer l'interface QGIS, certains de ses menus clés et les formats 

de données
• Apprendre à importer, visualiser et superposer différentes couches, 

ainsi qu'à extraire un sous-ensemble de données vectorielles et 
raster

.





Importer un fichier shapefile (.shp) dans QGIS (1/3)
1

2 3

Step-by-Step Instructions to 
add vector layers:
1.Open your QGIS software
2.Go to the Layer menu and 
select Add Layer
3.Choose Add Vector Layer
4. Geopackage –add all layers



Ajout d'une carte de base satellite via les tuiles XYZ dans 
QGIS (2/3)

to Add a Satellite Basemap in QGIS:
1. In the Browser Panel (left side), right-click 
on XYZ Tiles and choose "New Connection…"
2. In the New XYZ Connection dialog:
• Name: Google Satellite (or whatever you 
prefer)
3. Under URL, copy-paste inside the following 
link: 
https://mt1.google.com/vt/lyrs=s&x={x}&y={
y}&z={z} 
4.Leave other settings as default, then 
click OK.
5. In browser panel, Expand XYZ Tiles and 
double click on Google satellite to display the 
satellite image

1

2,3 &4

5
https://mt1.google.com/vt/lyrs=s&x={x}&y={y}&z={z}

https://mt1.google.com/vt/lyrs=s&x=


Numérisation d'une zone de couverture dans QGIS (3/3

2 – Zoom on the image and digitize 
the catchment

Start digitizing:

1. Right-click your new layer (Team 
catchment Area 1)> Toggle Editing

2. In the toolbar, click on the polygone
and  digitize the catchment on the image.

1

2



Numérisation d'une zone de couverture dans QGIS (3/3
Finilize the digitalization process:

1. Right-click once at the end of the 
polygon to finish.

2. Fill in the attribute table info when 
prompted (Egs Id: 1  Team: 1)

3. Save and Stop Editing:
1.Click the Save Edits icon 💾 (disk with 
pencil).
2.Click Toggle Editing again to stop 
editing.

1 & 2

3



Formation à l'utilisation des outils géospatiaux pour la micro planification de la 
campagne de distribution de moustiquaires imprégnées d'insecticide (MII)

-Estimation du nombre de bâtiments à atteindre par zone de couverture

The Alliance for Malaria Prevention Annual Partners Meeting
Mövenpick Hotels & Residence
Nairobi, Kenya from 7 - 11 April 2025



1⃣ Vector > Analysis Tools > Count Points in Polygon

Formation à l'utilisation des outils géospatiaux pour la microplanification de la 
campagne de distribution de moustiquaires imprégnées d'insecticide (MII)
-Estimation du nombre de bâtiments à atteindre par zone de couverture
Obtenir le total des points dans chaque zone
de couverture d’équipe

2⃣ Select the corresponding polygons and points layers



Obtain total counts of points 
in each team catchment area

A new layer Count is 
generated, representing the 
catchment areas.

The number labels shown are 
the total counts of 
points/buildings in each 
catchment area.

Right Click > Open Attribute 
Table > Stroll to the Right

Formation à l'utilisation des outils géospatiaux pour la microplanification de la 
campagne de distribution de moustiquaires imprégnées d'insecticide (MII)
-Estimation du nombre de bâtiments à atteindre par zone de couverture



The Alliance for Malaria Prevention Annual Partners Meeting
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Formation à l'utilisation des outils géospatiaux pour la micro 
planification de la campagne de distribution de moustiquaires 
imprégnées d'insecticide (MII)Analyse de l'accessibilité



Accessibility analysis

1. Analyse de l'accessibilité physique : Évaluer 
l'accessibilité physique des services de santé 
existants pour la population cible.

2. Analyse de la couverture géographique : Identifier la 
part de la population cible qui ne recevrait pas de 
soins en raison d'un manque de capacité.

3. Analyse des références : Mesurer le temps de trajet 
et les distances entre les structures de 
santé/fournisseurs.

4. Statistiques zonales : Identifier le pourcentage de la 
population ayant un accès physique aux services de 
santé dans un délai donné.

5. Analyse de l'extension : Concevoir et simuler 
différents scénarios visant à étendre le réseau de 
prestation de services existant (à pied, véhicules 
motorisés, etc.)

Accessibility analysis

Geographic coverage analysis

Referral analysis

Zonal statistics

Scale up analysis



AccessMod Next-generation, Web Version
(2022 release)

AccessMod 5.0, Standalone version 
(2017 release)

AccessMod

http://www.accessmod.org https://accessmod.openhexa.org/

http://www.accessmod.org/


AccessMod - Input geospatial data

Zones (division administrative, zones de 
santé)
GISC

Réseau de transport
HDX (Humanitarian Data Exchange)

Barrières à la circulation

Répartition de la population 
cible
WorldPop UNPD ajusté, 2024

Couverture du sol
Source : Sentinel-2 
10m 2024

Modèle numérique 
d'élévation SRTM 30m

Emplacement des établissements de santé
HDX (Humanitarian Data Exchange) Travel Scenario



Accessibilité (120 
minutes)

À pied + motorisé sur la route 
principale

AccessMod – Outputs

Grille de répartition du temps de 
trajet pour différents scénarios

Table

Walking+ motorized in main road

download

Étendue des zones de couverture basées sur le 
temps de trajet avec l'emplacement des 
établissements de santé/distribution ajoutés

Couverture de la population par zones



Result



Use of geospatial tools for microplanning of ITN distribution campaign
Resource estimation

The Alliance for Malaria Prevention Annual Partners Meeting
Mövenpick Hotels & Residence
Nairobi, Kenya from 7 - 11 April 2025



Le tableau donne une estimation de la population atteinte dans un
rayon de 2 heures de trajet et du nombre de maisons dans les
zones de couverture respectives. Ces informations sont issues du
modèle, qui est l'une des techniques permettant de dériver les
dénominateurs pour la planification du programme. Les participants
doivent estimer les ressources en fonction des tableaux.
• Quelle devrait être la meilleure stratégie pour atteindre

le maximum de population dans une campagne de
distribution de MII (Moustiquaires Imprégnées
d'Insecticide) ?

• Estimer les MII (balles) nécessaires pour la zone
• Calculer les besoins en stockage
• Décider si certaines zones de couverture nécessite des 
sites de distribution supplémentaires ou une 
communication ciblée pour rendre les zones inaccessibles 
accessibles, ou intensifier les visites de suivi.
• Expliquer comment la géo-enablement complète la 
microplanification conventionnelle.


